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Welcome to WebArranger 2.0! 
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Configure Internet Config, we ccccr eure tere ceetrreneervrrereeverenee 5 Thank you for your purchase of CE Software's WebArranger, the only . 
; information manager built for the information age. We’re sure you'll soon find it an 

Set Up The Grabber». ++ essere ereeeseres reese eee eeccere ree rccres 7 , indispensable companion for all your Internet and personal information management needs. 
Set WebArranger Preferences ..,.....00+ pee e wenn nna eeeneeaee vareeee 8 ; , 

You Want More? ....00000005 cam eeenecenecvevesenacttnsserteste 10 As you explore WebArranger, you’ll find that you own one of the most customizable 

Helpful Information .......sessees dcvaeuevcueeuaecsuuenerevutens 11 applications available today. We understand you want to organize your information your way. 

Keyboard Shortcuts s+ eeesecesesrevteesessrrnerecsercrecseccrans 12 | Stay tuned to our Web site for information on new WebArranger plug-ins, product updates, and 
Function Keys ....... cr 13 ; ‘cool extras available exclusively on-line. If you have any feature suggestions for future versions of 
File Formats ....eceeeaseeees ben eaeneeeaee decent eee e eee eeens 14 WebArranger, please send E-mail to feedback @cesoft.com. 

Again, thanks for your purchase of WebArranger. We're confident you'll soon wonder how you 
ever surfed without it. 

FEATURES 

On-line Help 

We’ ve included a WebArranger Help Document. Just 98-? or select Help in your Apple menu. 

And, we’ve embedded a special notifier agent to tell you when we update the User Guide at the 
CE Software Web site — http://www.cesoft.com/webarranger/wadocs, html 

Use WebWhacker to whack the User Guide for off-line reading. Enjoy the power of a linked html 

. User Guide right on your desktop. . 

Default Template . ; 

When you launch WebArranger, you’! have a working document ready for you. It’s complete with 
a variety of Folders, Topics, and examples already set up io help you get going. And it’s loaded with 
Internet addresses in URL Notes, ready to take you to fascinating places on the Web. 

Netscape Navigator Support 
WebArranger 2.0 provides full support for Netscape 2.0 history and bookmarks. 
Anarchie bookmarks are supported, too. 
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The Grabber TCP/IP {Transmission Control Protocol and Internet Protocol) connection to the Internet 

The Universal Grabber captures information and graphics for you, any place, any time. You can 
grab a URL, text on a Web site, a piece of a Microsoft® Word document, an image in Adobe Photo- 
shop™, or an E-mail message — whether or not WebArranger is running! And, you can define your 
own easy hot keys to activate the Grabber, ; 

System software version 7.1 or later 

Internet Config v. 1.2 (provided with WebArranger) 

Floppy drive for installing WebArranger (if you are installing from a disk) 

Grabbed material is placed in the Clippings Topic. URLs are placed as URL Notes. Other items are 
placed as Memo Notes, The Clippings Topic is located in the My Data Folder. 

WebWhacker INSTALLATION 
We have bundled WebWhacker™ with WebArranger : . 
because it can reduce your dependency upon an Intemet 
connection. 

  

You may have received WebArranger 2.0 from an on-line service or as a set of disks, By the time 
you see this document you may have already installed WebArranger. So, if you're already up and 
running, Congratulations! Welcome! You can just skim this part. 

Use WebWhacker to download (aka whack) entire Web 

sites to your hard drive, Look at your favorite Web sites 
even when you're nof connected to the Internet! 

To install WebArranger: 

1° Verify there’s enough space for WebArranger (4 mb). 

  
ND

 For more information about using WebWhacker, see its Restart your computer with all extensions and anti-virus programs turned off, Hold down 
Topic in the WebArranger 2,0 Template. the Shift key while you Restart. 

  

  

    
  

  

          

URL Validator 3 Double-click the install icon, 

Have you ever used a URL, only to discover it no longer works? WebArranger’s URL Validator 4 Click Continue. 
Agent gets that information for you. 5 Read the Read Me. 

The Validator checks http URLs in your History Topic, and puts invalid ones in a special Topic, The 6 Click Continue. 
History Topic auto-collects all URL Notes in your Document. The Validator also attaches an Error 7 ~~ Select your type of install. 
Description field to each invalid URL, so you’ ll know if it is no longer active or if it has changed. . . . Install the following: 

8 Click Yes to restart after installation. : 

FTP Download . 9 Specify the location for WebArranger webrranger 
We got so frustrated trying over and over to download from busy Anarchie FTP sites, we created an and its files to be stored. eer 

agent to do it for us, The FTP Download Agent attempts to download files from specified FTP sites — 
at intervals you define. When a file is downloaded, its URL is put in a special Topic, showing that ¥ ar ere  nMton of Webber anger nd Webienacker 
your download is complete. . i 

inslattation requires 2 4749K 

SYSTEM REQUIREMENTS 

. For best performance to use WebArranger, a Web browser, and Intemet Config together, these are 
your sysiem requirements: 

m Hard disk with at least 4 megabytes of free disk space 

m 12 megabytes of RAM 
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  10 Enter your Activation Key and 

name (they are required), and your Webfirrenger Personalizatian 
  

company (that’s optional). User Nome: {rt tti“‘C;OSC‘é*@C Click OK, 

If you are installing a demo activatt - 
: . . . : ! < 

version, it will expire in 30 days. tivation Key 

This time-out also applies to the 
WebWhacker application, Your       

expiration date is displayed in the 
WebArranger About box as well as on the application's opening screen, 

111 Insert disks as requested. Depending upon your configuration, you may not need all three 
disks. 

-Launch WebArranger 

To launch the application, double-click the WebArranger icon. 

The first time you launch WebArranger, you're looking at a template. Now you need to save and 
name it as your document. Select Save in the File menu, 

THE WEBARRANGER FOLDER 

After installation, a Folder named WebArranger Folder displays on your hard disk. It contains: 

WebdArranger 2.0 —- The application. Double-click this to run the program. 

WebWhacker Folder — The application. Installed with WebArranger, Access in the 
Tools menu. - 

WebArranger Help — On-line help Document. 

Organizer Template — A template designed for personal information management. See the 
“Cool Tricks and Hot Tips” book for information about using it, 

Plug-ins Folder — Any plug-ins installed with WebArranger are installed into this Folder. If 
you install plug-ins later on, put them into this Folder. Keep this Folder in the same Folder as 
the application. 

Icon Library — A collection of icons to use when you create Topics and Note types, Keep this 
file in the same.Folder as the application. 

Getting Started Folder — Files and documents you use to complete the Getting Started tutorial 
in the User Guide at the CE Software home page on the Web at: 
hutp://www.cesoft,com/webarranger/wadocs.html 

Internet Config 1.2 — This application is the bridge between WebArranger and your other 
Internet applications. Its Folder contains extensions and user documentation. 

“ Note: If you install WebWhacker by itself, Internet Config is not installed. 
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CONFIGURE INTERNET CONFIG 

First things first. Before WebArranger can do its tricks, it has to know which Internet applications you 
want to use, among other things. Internet Config tells WebArranger which Internet applications to use, 
and you tell Internet Config. Make sense? OK, let’s make this a little more clear. 

1 Launch WebArvanger and select Open “Internet 

Config” in Internet Apps in the Tools menu. 

If you don’t already have a copy of Internet 

Config, a message displays indicating the 

Internet Config Extension is not installed and it 

asks if you would like to install it. Yes you 

would, so give it the OK. it tells you when the 

  

Open “Internet Config” 
Opes “WebWhoacker® 

  

  
Wed Browser (Netscape Navigaior™) 
FTP Client (Anerchie) 
Mail Client (NewsWatcher) 
News Wotcher Client (NewsWatcher) 
Tetnet Cilant (NCSA Telnet) 
Gopher Client (urboGopher} 
  

installation is complete (don’t worry, you won't have to Restart). 

  

  

Preferences window. oh 

Click the Helpers button in the Internet === SS iitemnsl Proverencos 
(ely = “Tes 

  

Select the applications you want 

WebdArranger to use in the Helpers dialog, 

The Helpers dialog displays a list 
of the types of applications you a 

   
      

  
Helpers 

  

  might need, including http, ftp, 
mailto, gopher, etc. 

application to use, highlight an item 

To tell Internet Config which “ finger — Finger 

and click Change.. 
hie, STENTS) SERGE Ree 

For example, your browser should aie ° Te ene ae 
be your “http helper. Qa http — Macweb 

Internet Config finds default 
applications already installed on   your machine, but you may not &Q netphone ~ Ne(Phone 

ZA aditor -- Simpletext 

ftp — Anorchie 

mailto — NewsWotcher 

     

  

    want to use those, .   
  

For example: If you selected 

Netscape as your browser, Internet 
Config defaults to Netscape as your mailto Helper. You do not have to choose it in the | 
Helpers dialog. 
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5 The Add Helper dialog displays, 3 Provide your information in the Identity and Servers options. 

Click Choose Helper to display a standard 

  

  

  

  

dialog box. Scan your drives and point to N veer: * HESS — Others 
your Internet application for each Internet Click the Email button in the Internet Preferences 

Config Helper you want to use. (toner) (0) dialog. Complete the Email dialog with your tmalt Raciess: 
: [Concet ) [ oc f ‘ t Cmall fecount: 

For example: Point to your Web browser as Ce i information. Emali Password: 
your http Helper. SMP Kost: 

\ Emeit 

Eudora 

To use Budora™ as your mailto Helper, select the Eudora GURL Handier in the Internet 
Config folder’s Goodie Folder. SET UP THE GRABBER 

. . oy | Grab a URL from anywhere! Grab information from anywhere! Grab a graphic from anywhere! .., 
Repeat steps 4 and 5 until you have pointed Internet Config to all the applications you want to use. You get the idea 

Define File Transfer Download Folder . WebArranger’s Grabber™ captures text and graphics so you can add them to your WebArranger 
The Internet Config File Transfer dialog helps you set preferences related to the transfer of files Notes, And WebArranger does not have to be running when you grab! 

from the Internet to your computer using FTP. 

Do it with a hot key 

1 Click the Fite Transfer button in the You can set up the Grabber to work with the hot key of your choice: 
Internet Preferences dialog. 

4 Select Grabber Preferences in Preferences in the File menu. 

  

    

  

  

  

  

      
  

Enter your hot key in the Grabber text box, if you 

don’t want to use the default, Use any W Grabbor Preferences 
combination of the four modifiers (Shift, Control, crapper: T = 

2 Click the Download Folder button, 5 SS Option, Command) and one other key, Or, you can renner 
Specify where to put downloaded arevie sewer, (Uieise >] use a function key, WabReranger: 

information from FTP sites. This location [an (iia, tems) This key will grab what you have selected. tot keys enabled 
is placed by WebArranger in a field called ; & Moke sound when grabbed 
Downloaded File. UMIch Server: USA, Utowe x 3 Enter your WebArranger hot key, if you don’t want to 

When WebArranger’s FIP Download Download Folder: use the default, 
Agent puts a URL in the Successful FTP / This key will either launch or go to WebArranger. 

‘ Downleads Topic, it adds the Downloaded File field to the URL Note. From this field, 4 Select the checkbox to enable your hot keys, 
t . 

you go to the downloaded information. i 5 Select the checkbox for the grabbed sound. 
Internet E-mail Preferences _ G click OK. 

If you are using an Intemet E-mail application, be sure your preferences are set up. ( 

Netscape How to use the Grabber 
To set up your preferences: . 

14> Select anything you want to capture from any application, Internet site, or from any 

1 Launch Netscape electronic source. 

2 Select Mail and News Preferences in the Options menu 2 Press your Grabber hot key. When your selection has been grabbed, you hear chimes. 
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3 Most captured data is placed in the Clippings Topic as a Memo Note, Grabbed URLs are 

placed in Clippings as a URL Note. Clippings is located in the My Data Folder, 

The Clippings Topic in the WebArranger 2.0 Template has some examples of grabbed 
stuff, 

4 Press your WebArranger hot key. If it is running in the background, the hot key brings 

WebArranger to the front. If WebArranger is not running, the hot key launches the 
application. 

5 f WebArranger is not running when you grab something, the item is stored in a temporary 

file until you open WebArranger. You can grab more than one item before you open 
WebArranger. 

G When WebAranger is launched, the item is placed in the Clippings Topic. From the 
Clippings Topic, you can drag the Note to another Topic as a Note. 

Or, you can copy the data into a Note, 

Or, you can convert the Note to another Note type, Select Convert Note in the Notes menu. 

Note: The difference, between using the Grabber and the usual copy and paste commands, is that 
the Grabber works even when WebArranger is not running. 

  

SET WEBARRANGER PREFERENCES 

STYLE 

DATE 

  WebArranger gives you plenty of control over its features. 
The Preferences sub-menu in the File menu is where you 
tell WebArranger's various elements when and how to do 
their work. Maybe you’ve already been in Preferences to 
change your Grabber hot keys (see above section). 

Style Preferences... 
Dete Preferences... 

Document Preferences.., 

Home Document... 

Grabber Preferences... 

Internet Plug-in...       

The Style Preferences set your default settings for text styles. 

The Style Preferences dialog box gives options for default style settings for Folders, Topics, 
Summary Line, tables/calendars, text, and field names. 

Individual field and Note definitions have text style settings which override these defaults. You can 
further override the default settings for selected field text and table views. 

y 

The Date Preferences set the date style. WebArranger has three styles for fields defined as date 
type: 2/27/96 or Tue, Feb 27, 1996 or Tuesday, February 27, 1996. Use the pop-up menu to select 
the date style you prefer. 

Jump Start-WebArranger 2.0 Jump Start-WebArranger 2.0 

The date/time at the left side of the Topic title bar shows the current date style, and can be used as a 
date/time stamp for a Note. Select a Note, and click the date/time. The date and time are added to 

your Note. 

DOCUMENT 

You can set preference settings for each WebArranger Document. 

As a default, WebArranger does not compress files as it saves them. The Document Preferences 
dialog has threé checkboxes for save specifications, They can be selected independently and 
concurrently: 

Fast Saves 
We recommend you do nof use the Fast Save option. Leaving Fast Save disabled reduces the overall 

WebArranger Document size by up to 50%. Individual savings may vary. 

Auto-save every ___. minutes 
Sets a time period for regular saves of the Document. This option is not selected by default. 

Backup 

By default, we recommend you save your Documents in TAIL format every day. The TAIL format 
can be used as a recovery file in the event that any information is lost or damaged in the original 
Document. TAIL files cannot be password protected. 

Without going into a lot of engineering details, WebArranger is built on an object-oriented database 
—- this means WebArranger can hold just about any kind of electronic information you can get and 
you arrange it however you want. 

This information is stored in a sort of “object soup.” So, to effectively protect the data, we 
recommend you save it in a more hierarchical file format ... TAIL. 

Saving in the TAIL format may take a bit longer than you are used to, We believe the benefits of 

WebArranger's power and flexibility are well worth the short time it takes to make a hierarchical 
snapshot of your data, 

Add Password... and Remove Password... 
You can protect your WebArranger Document with a password, 

HOME DOCUMENT: 

The Home Document is the defauit document that opens every time you launch WebArranger. 
It is also the Document that contains the Clippings Topic when you use the Grabber, 

WebArranger 2.0 ships with a template ready for your use. As recommended in the Installation 
section, name your Document with Save in the File menu as soon as you get started, Then, 

specify your Home Document.



INTERNET PLUG-IN 

  Two preferences set the intervals for WebArranger 
Agent activities. [FA] 

A URL Agent UAL Agent cperates ai most 

The URL Agent monitors the specified http URLs for once every [fil] (22 ¥ 

changes. To specify a URL, put a copy of a URL Note 

Enfernel Plug-in Preferences 

FIP Downiood Agent operates st most 

in the Topic, URL Agent. The Agent checks the sites once every[t 

for you, so you don’t have to look yourself to see if any £4 Use dinlog when Web page changes 
thing has changed. URL Agent puts the URLs of prema nn nged sites in he Topi, Cha ean CED changed sites in the Topic, Changed Web Pages.       

Set the intervals here for URL Agent checking. Select 
the checkbox if you want a dialog box to alert you when a change has been detected. 

Note: URL Agent looks at the “last modified” field in a Web page’s http header. If this field is not 
present, URL Agent can not work as described and the affected URLs are put in the Changed Web 
Pages with an error field attached. It may be helpful for you to contact the WebMaster at a site 
which does not use this field, if you want its URL checked by URL Agent. 

FTP Download Agent 
The FTP Download Agent can save the time spent waiting for an Anarchie FTP site to be available 
for downloading. It attempts to download files from the specified ftp URLs for you. To specify a 
URL, put it in the Topic, FTP Download Agent. The Agent puts the downloaded files’ URLs in the 
Topic, Successful FTP Downloads, Each file you want downloaded must have its own URL. 

Set your intervals for FTP Download Agent atternpts in the Internet Plug-in Preferences dialog. 

FTP stands for File Transfer Protocol. This is a common way of moving files between two Internet 
sites. It’s a special method to login to another Internet site to get and/or send files, There are many 
Internet sites which have established publicly accessible files of material that can be downloaded 

using FTP, 

  

YOU WANT MORE? 

40 

For more information about the power, flexibility, and cool stuff WebArranger has, see the 
WebArranger Help Document that shipped with WebArranger 2.0. 

And there’s more information at the CE Software Web site at 

hitp://www.cesoft.com/webarranger/wadocs.html 

We've embedded a special notifier agent to let you know whenever we update the User Guide. Use 

WebWhacker to get the documentation ... then you can peruse it off-line! 

Jump Start-WebArranger 2.0 

AND WE WANT YOU TO KNOW... 

This chapter provides some extra information we think you'll 

find helpful. 

The WebArranger Help Document provides even more! 

THE BIG PICTURE 

Below is an illustration of your WebArranger window. 

  

  

Contents The infamous triangle Document title bar 

Icon bar 

        

   

        

  
Folder —- oo ; 

. To ic _] QP Hows Shing Michigans hep tne cru pal conviraeine thtirhorde hint if 

P conn eae oie nema 
wd aceding URL 

My Date fast Vismed: p Chg) Fe, beat, 15 @ 19:0 aa 
C59 pings Bet este YR: POD 

Drop-down list lcon— 

Adjust Shelf height —=! 

  
comnts Mate ent Sub-note 

Last Vieited: DG Ta, San, teed eT) A we 
  woe Tr 

1 © Mercery Center Hore Page hip dive s)ynercuy.cont 

@& # rternat Disaster iréorration Center tap 9165.247.168.907 

@ D TSSTS Mp se davimouthedupages TT STMBITS td 

fT fate 

  
Note type icon —--           

Topic or View title bar 

Grabbed graphic 

@ © Mountain bking hip Rxenonstarterd edu-reirin-bice Hind Summary line 
‘ Hews 

Shelf — FY et NewsPage_hipteret bhcombeH! 

    

Jump Start-WebArranger 2.0 14



  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

      

Keyboard Shortcuts 

Shortcut What it does 

BA Select all Notes in a Topic or View 

eB Bold text 

eC Copy 

sD Duplicate Note... 

8E Set Alarm 

ek Find... 

2G Find Next 

sel Italic 

sed Go to... 

ek Destroy Note; warning dialog displayed 

L Next Appearance 

#M Gather (query by example) 

seN New Note; dialog displayed 

#0 Open... 

#eP Print 

#Q Quit, 

eR Launch URL 

- 3S Saye . 

eT Plain text 

aU Underline text 

weW Close decument if front window is a document 
window; if front window is a catalog, close the 
catalog 

ex Cut 

#eY Time/date stamp (same as to click the time 
display in topic header bar) 

eZ, Undo/Redo 

seReturn New Note; no dialog displayed; Topic’s default 
Note type .   
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Function Keys 

  

  

  

  

  

  

  

  

  

  

        
  

  

  

Shortcut What it does 

Tab Move to next field in current note or dialog 

Shift - Tab Move to previous field in current note or dialog 

9 Expand Note 

8 Filter... 

883 Collapse Note 

= Update now (View) 

98? Help 

se[ Close Note 

38] Open Note 

96. Cancel a dialog; force quit some operations 

Key Use 

Home/End Scroll to beginning or end of Hist 
  

Page Up/Page Down Scroll up or down by one screenful 
  

Forward Delete Delete selected text, or character after the 
insertion point 
  

  

sxArrow keys Up and Down moves the selected Notes up and 
down. 
Left and Right promotes/demotes the selected 
Notes, if possible. 

Control Up and down act as Page Up and Page Down 
  

Control-Shift Up and Down act as Home and End 
  

Shift-Click Multiple select 
  

  

  

  

    
Option Up and Down select the next or previous text field 

(contents) or Summary Line. Left and right move 
by words. 

Backspace Destroy Note 

sOption-Backspace Destroy Note} no dialog 

a¢Clear Destroy Note 

Enter Same behavior as Return Key       

Jump Start-WebArranger 2.0
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Key Use 

Fi Undo 

¥2 Cut 

F3 . Copy 

¥F4 Paste 

Help Opens the Help Document (same as the Help 
command in the Apple menu) 

Escape Cancels a dialog   
  

  

File format What it does 
  

Text, one | per note Links together the contents of ail fields in a Note, 
then inserts a paragraph retum. If you have 
paragraph retums within the contents of your fields 
(like in a paragraph of text or a multi-line address), 
they will appear as well. 
  

Text, one { per field Exports the contents of each field onto its own line 
in the text file. 
  

Text, one J per field 
(UNIX®) , 

Exports the contents of each field onto its own line, 
but also limits the number of characters on a line to 
80. This is for compatibility with computers that run 
or communicate with the UNIX operating system. 
  

Text, named fields Exports one field per line, but precedes the contents 
of each field with the name of the field, a colon, and 
a space. It also adds a blank line between Notes. 
This format is useful if you want to use the 
information in a WebArranger Topic or View on a 
computer that only supports simple text editing. The 
field names make it easy to see the structure of your 
information. 
  

Text, named fields 

(ONIX) 
Same as “Text, named fields” except that lines are 
trimmed to 80 characters for compatibility with 
computers running UNIX. 
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File format What it does 
  

TAIL WebArranger’s special information language 
format. Use TAIL to send Topics and Views to 
other WebArranger users, so they can bring the 
information into another WebArranger Document 
using the Import or File Merge commands. 
  

Tab Delimited A common file format. The contents of fields 
within a note are separated by tabs, while the Notes 
themselves are separated by returns. When you 
choose Tab Delimited, only the top level Notes are 
exported. 
  

Comma Delimited A common file format. The contents of fields within 
a Note are separated by commas, while the Notes 
themselves are separated by returns. When you 
choose Comma Delimited, only the top level Notes 
are exported. 
  

Mail Merge A structured file format designed to help you create 
lists of information to use with the mail merge 
feature of a word processing program. The Mail 
Merge format is more sophisticated than the Tab and 
Comma Delimited formats, because it exports not 
just the contents of fields but the names of the fields 
as well. This allows word processing programs to 
ask you questions about the mail merge procedure 
using the actual names of the fields from your 
WebArranger Document. 
  

  

Arrange File The standard file format for WebArranger, Saving 
a copy of your file in this format is the same as 
duplicating the file in the Finder, Re-cpening a file 
saved in this format results in a Document that is 
identical to the original. 
  

Text Exports your entire WebArranger Document as a 
simple text file that can be read with any word 
processor. You can’t use the Open command to 
re-open a WebArranger Document that has been 
saved as text. But you can import it using the Import 
command, The resulting Document won’t be the 
same as the one you saved, because text files can’t 
contain the structural information that 
WebArranger uses to organize documents, 
  

WebArranger Template     Saves your WebArranger Document as a template 
file. Template files are like stationery pads. You 
choose from a set of template files when you use the 
New command to create a new Document, Saving a 
file as a template lets you extend the set of templates 
that WebArranger can use.     
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A Quick Tour 
of WebArranger 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

    

Shortcut What it does 

sw Close document if front window is a 

document window; if front window is a 

catalog, close the catalog 

BX Cut 

aBY Time/date stamp (same as to click the 

time display in topic header bar) 

geZ Undo/Redo 

sgReturn New Note: no dialog displayed; Topic’s 

default Note type 

Tab Move to next field in current note or 

dialog 

Shift- Tab Move to previous field in current note or 

diaiog 

‘ Expand Note 

Filter... 

8; Collapse Note 

= Update now (View) 

8? Heip 

sel Close Note 

$8] Open Note 

$B. Cancel a dialog; force quit some 

operations   
  

Weba\rranger 

Start Here 
  

‘Contents: 
  p> Find the Contents portion of the screen. This is your filing cabinet. 

[tis the keeper and organizer of all of your “stuff.” Everything you 

create in WebArranger will five here. 

p Find the Fo/ders in the Contents Section. 

These are your file drawers. You can fill these drawers with any 1 

number of fopics. Unlike a traditional file cabinet, you can add as 

many file drawers as you want. 

p Check out the 7opics within the Folders. Topics reside 

in your Folders and are a collection of Notes that you compile. 

  

Getting Around the Contents Section 

fF QuickTour 

   

  

   

Jump Start 

B@AREAD NOW II! 
J Top Ten FAQs List 

Cool Picks 

My Data 

Clippings 

Pecple 

— Web Schedule 

% User Defined * | 

User Defined *2 

  

(SS Bookmarks = 
ry internet 

p> To open and close Folders, click once on the folder icon. ___ | LIE History 

p> To display fopic contents, single click on the icon or title 

(your information will appear to the right). 

p> To move any Folder or Topic, just drag-n-drop to another location 

within the Contents section. 

p> To discard any Fo/der, Topic or Note, simply drag it to the 

WebArranger trash can (it is the last icon in the Contents section). | 

p> To add a Folder or Topic, click on the icons to the right of the 

I
 

  
    
   
   

WWW Foot Steps 
(2) Invalid URLs 
GQ) FTP Download A... 
3 Successful FTP ... 

crf WebWhecker 

L_ fil Trash 

Z         
  Contents title bar. 

  

Go Here Next! 
  

p Every office has a Shelf, Your WebArranger Shelf is located in Shelf +
 

  

the jower left corner of the screen. 

p> Check out the buttons! They are used to create new, blank 

Notes, the items stored under each of your Topics. 

Gistting Around the Shelf 
p> Creating all those Notes and filling your Topics is easy! 

1, Simply select a fopie in the Contents section. 

2. Go to the Shelfand click on the type of Nofe you'd like to create 

(URL, Heading, ToDo, etc.). 
3. A blank Note will appear for you to fill in. 
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DON'T PUT THIS. 

Okay, we'll be the first to adn 

shelf or get buried in your de 

The WebArranger Hot Tips é 

terminology and cool feature 

WebArranger is a very deep, { 

So read on, and see how Web 

your day-to-day computing | 

ins, and ready-made libraries 

We'd love to hear about how 

can make it even better. Pleas 
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A Quick Tour 
of WebArranger 

    

  

Let's Keep Movin... 
p The largest portion of the WebArranger screen is the Page. Think of it as your work area. 

When you choose a Jopic, all the Notes that you have created within that Topic appear 

here. There are three types of views: basic, table and calendar. 

> You can see which /opic is being displayed from the title bar at the top of the Page. 

Getting Around the Page 

» To Select a Note on a 
a Page in basic view, & > Cool Picks is alist of sites that are cool, informative, and interesting IOHO (in our humbi... 

click on the Notes OO” BP Legal ans Ganeral’s hitpyAwww iegal-and-general.co.ukAgs 

icon. You'll know € » Mutual Funds Online httpyAwww.mimag.com 

you've selected it ® Quicken Financial Network httpAvwww.gin.cony e p q 
1 €} > The American Stock Exchange - The Smart... htipyAwww.amex.conv 

when a rectangular cy cou Places 
box appears around @ ” Cé Software Home Page _hitpswww.cesolt.conr 

URL: HtptAruw casoticm/ 

the Note. : aah Comment; GE Sotvean Hone Page 
‘ Last Visited: DEQ) Wed, Feb 4, 1996 @ 9:47 AW 

p> Ifa black triangle ——~ Kext Tine to Visit: POO 
appears between the 

    

  

  
  

@ © City.Net United States htipvAvyw.city.nevcountriesdunited_statesy 
. & * Cool Site of the Day htip-/cool inti.ney 
icon and the name, © " David Letterman - Top 10 Lists hitp-/Awww.chs.conviateshowstlist. him 
that means there are & > ESPNET SportsZone http espnet.sportszone.cony 

type  MacroMedia hitp/Avwew.macromedia cony 

subnotes within. To 8: Netscape’s Net Search htip-nome netscape .comynome/ntemet-search him 4] 

display those @ ® PC Magazine Top 100 Sites hilpyAwaw.zdnet.conypemagsspacialveb 100A0p 00... [i 
subnotes, @ © Word of the Day http4Awew.dsu.edu/projectsAvord_of_dayAvord, html ca 

© » 2D Net Sites httpyAawy.zdnel convnomedillers*magrack. him   simply click on the 
triangle and it will 

rotate, oF 
p> To view the contents of that NVofe, click on the text. 

p> You can crag-n-drop between the Page, She/fand Contents sections. 

Always remember to grab the icons, not the text! 

  
  

You've Just Gotten Started... 
Now that you can navigate your way through the WebArranger office, you're 
ready for some power tools and Internet integration. Head straight for the 
Hot Tips and Cool Tricks Book! Have a blast! © 
© 1996 CE Software, Inc, CE Software, the CE Software logo, and WabArranger are trademarks of CE Software, inc, 
All other brand or product names are trademarks or registered trademarks of their respective holders. 

sh Dh 
  

   

  

   
Shortcut What It does 

  

  

  

  

  

   

  

  

  

  

  

  

  

  

GA Select all Notes in a Topic or View 
ao ue vecet eee 

cae Copy 

0 Duplicate note. i 
eE Setalarm 

Donk Find 
eG Find Next 

Hi Italic 

id Got. _ 

aak Destroy Note: warning dialog displayed 

3L Next Appearance 

| aM Gather (query by example) 

aN New Note: diafog displayed - 

Oo (Open, 
wP Print - OO 

a8Q Quil 

aR Launch URL BO 

BS Save / 

aT Plain text - 

7 aU Underline xt oO     
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A Quick Tour oe | 
f WebArranger Ta , J Rein 

|__l DON'T PUT THIS MANUAL ON YOUR SHELF! 
‘Contents: (Slt 

{Fy QuickTour A 

— Jump Start ca ‘ : ‘ ‘ 

POAREAD NOW!I| Okay, we'll be the first to admit it — today, software manuals are generally a “last resort” when a question arises, They sit on your 

Top Ten Fags List shelf or get buried in your desk drawers, in case a crisis occurs, But don’t file this one away quite yet ... 
Cool Picks . 

P-L My Data The WebArranger Hot Tips & Cool Tricks Guide was written with you in mind, It’s a quick, to-the-point introduction to the 
Chippi ; ; , 
People a terminology and cool features found in WebArranger. If you haven't already done some exploring, you'll soon find that 

——_|_ HE web Schedule WebArranger is a very deep, feature-rich application, and accordingly, there’s much to learn. 
E3 User Defined #1 
5 So read on, and see how WebArranger will transform a formidable information overload into a clear and manageable asset in 

your day-to-day computing life. Be sure to visit CE Software’s Web site often for new tips, tricks, templates, WebArranger Plug- 

ins, and ready-made libraries of URLs for all interests.   
We'd love to hear about how you use WebArranger to make your life easier, what you'd like to see in the next version, or how we 

can make it even better. Please direct your feedback via E-mail to feedback@cesoft.com. 

GY FTP Download A... 
= Successful FTP ...       oL
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COOL TRICKS 

The Note is the most hasic element of WebArranger. 

Without going into any deep engineering details, WebArranger” is built on an object-oriented 

database ~~ this means WebArranger can hold just about any kind of electronic information you can 

get. Notes are the basic, building-block objects, akin to records tn a database. They store your 

  

captured information any way you want. Notes are completely flexible. 

Collections of Notes are filed under Topics, and each collection of Topics is kept in Folders. For example, a 

Macintosh enthusiast could create a Folder titled Mac Stuff. Inside that folder, he could keep Topics such as 

Hardware, Software, User Groups, etc. Notes kept inside these Topics would probably include URLs 

pointing to Web sites pertinent to each Topic. You'll learn more about Topics and Folders as you read on. 

  

NOTE TYPES 

  

WebArranger provides a basic set of seven Note types. Theyre designed to hold your most commonly used types of information, 

as listed below. More Note types are immediately available to you, as is the ability to customize your own, but we'll explain 

that later. 
  

  

  

  

URL & > Central Intelligence Agency Home Page hip. Avww ode: gous 

UAL: hip ly oder govt “a , 

The URL Note stores an Internet address, URL is the abbreviation for Comment: Central Inellgenne Agency Hore Page 
: Last Visited: 9 © Mon, New fF, 995 9 SF aM 

Universal Resource Locator. Hext Tine to Visit: 9 AO 
  

To Do 

To Do Notes have a field which links to a URL Note, The To Do Note 1s a |? Vis the Internet Summary: visbiie intsrnst 
  

fast way to schedule your visits to the Internet. You can also use the To URL Link: GB 3 i» Ask Or Science htp Jagora.rdrop coml=yin 

Do Note to schedule personal appointments in your calendar. Priority: & 
. . . Begin: DOO 

The WebArranger calendar (stored in the Web Schedule Topic) will Completed: [7]   Date created: Mon, Feb 12,1996 @ 8 22 PM 
  display To Do Notes in your calendar until you fill the “Completed” 

field’s checkbox. 

© WebArranger 2.9 

OF course, vou can place 0: 

as To Do Notes will. 

Asam exdiiphe weve putt 

Heading 

The Heading Note is desig 

Forexample: You have aH: 

Heading isa collection of L 

featuring news about the gi 

Picture 

A Picture Note lets vou disy 

Ivpe. inchiding URL. 

Memo 

The Mento Note ts a gener 

place graphics and/or write 

People 

People Notes contain perso 

Hioned as asub-note toa Pe 

sub-note. You can “nest” in 

capabilities. 

File 

The File Note points to tile: 

computer, You can arrange 

applications, ete., so you de 

file into WebArranger. 
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example, a EI Mac Stuff 
pics such as Software 
URLs Hardware 
read on. Ge User Groups 

nonly used types of information, 

rour own, but we'll explain 

  

mmoy Home Page hiip-Avww.odoi gow 
http:ivww.odel.gov 

Central Intelligence Agenoy Home Page 

BEV® Men, Nov27, 1995 @ 9:27 AM 

eo 
  

  

  

ternet 

Sk Dr. Science hilp:Nagora rdrop.comi~fim... 

+   £2, 1996 @ 8:22 PM 

WebArranger 2.0 

  

   
Of course, you can place other types of Notes in your calendar, although other Note types will not carry forward to the next day, 
as To Do Notes will. 

As an example, we've put a visit to CE Software’s Web page in your Web Schedule Topic. 

Heading 

The Heading Note is designed to be just a name of a group of Notes. 

For example: You have a Heading Note named Milky Way. Below that 

Heading is a collection of URL Notes that point to Web pages 

featuring news about the galaxy. 

Picture 

A Picture Note lets you display a photo or graphic. You also can paste graphics into just about any Note 

type, including URL, 

  

  

¥ Milky Way 
Heading: Niky Way 

f ¥ What's gaing on in our galaxy. 
What's going on in our galaxy. 

@ 1} hiipdhww2 ari nethomelodenwakikcafe.him! The Astronomy Cafe 

& | hiptiww.ul-nolnptihomepage-npten.himt The Northern Lights Planetarium 

@ P hitpziss| berkeley.edulisi_wrnisatpasses.him! SatPasses Home Page 
  

  

fal ? Or. Metingion B 
Sammery: Dr. Wellington 

Picture: 

  

tearrange them? 

The Memo Note is a generic, no-frills Note. You can aapating Ue Hetcape Doserarme, Tsuna wan Bookmarks. Unkiwe crenmed ip poring and 
Now we fust use the Heading note to make outtines of our imported bookmarks, And then we expoct ourbookmark 

Pe place graphics and/or write text in a Memo Note. otbioe beck lo escape, 

  

Mema e & 4 fore bookmarks [make hem af over the place. Lota of boobnarks, And Srey’rt geting oul of ha. 

4 love bookmaricg, Imake Unem allover the piace. Lots of booksrautes, And they're getting out of hand. Any way tof 

This works with Anarchie bookmarks, toot 

    

  

  

  
  

D ¥uleson Wellington Mr. Happy Tooth   People 

People Notes contain personal contact information. This example shows a Picture Note posi- 

tioned as a sub-note to a People Note. Any Note indented beneath another Note is referred to as a 

sub-note. You can “nest” notes as deeply as you like using WebArranger’s free-form outlining 

capabilities. 

File 

Fest Name: Jason 

Lest Meme: Wellington 

Exad: inalioctyy@ealcom 
Company: Mr. Happy Tooth 

Tale: best dentisit fre ever had 
  

> Dr. Wellingion B 
Swamary. Or. Wellington 

Picture:   
  

The File Note points to files of any type on your 

computer. You can arrange references to documents, 

applications, etc., so you don’t have to bring the entire 

File Hame: () What's new 

Comments: Ranger Rick’s receipes 

[ |] © Aanger Rick's receipes ne   
  

        

file into WebArranger. 

WebArranger 2.90 
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The Page is where your Notes are arranged. 

The Notes in a given Topic are displayed on the Page, The title at the top of a Page is the name of 

the Topic it is displaying (see The Contents), 

The Notes are arranged in outline form on the Page. The Page makes up most of your WebArranger 

er
r,
 

  

screen. From the Page, you can move, sort, manage, create, and manipulate information. If you use 

a large monitor, WebArranger will utilize as much screen real estate as you have, giving you the “big 

picture” of your information. 

You can look at your information differently through 

Views, The available Views of each Page are displayed in 

drop-down lists beside the Page Name and beside the 

Topic Name. 

WebArranger ships with predefined Views you may 

find helpful. You can also create more Views. See the 

Cool Tricks section at the back of this guide for tips 

about WebArranger’s customizable Views. 

Contents faejied 

&, Revelations ay 
= 

pio oo6aney S fe ee Raokmarks clos 
Ge: : URLs and Headers 
  

   

   

  

Jump Start 
wig 3 & READ NOW! 
(A Top Ten FAQs List 

Cool Picks 

; 

  

    

fii) UserDetined #2 just UALs 

internet Scheduled visits — | Museum bite tiwww neh gov sginhby 

  

  
  

  

    

  

& > Bookmarks gives you more control over your Netscape bookmarks 

CD ¥ Daily Trips 

& ib Word of the Day hte dawww dsu edulproject 

€&} P The American Stock Exchange - The Smarter Po fithp diver 

=] ® Mutual Funds Online hip iwww mimag com 

€} The Monty Python page hitp Haired u wasrington 

(77 ¥ A Good Time 

2) Discovery CharninelOnhine hit lawns discovery corn 

bird Places On The Met bite fhawww euronet miluser 

sole lhcbe 's Web Wortd hitp.ticyclone weather neut 

BP Add-A-Fright http thyww aze corniclient 

(77 ¥ Looking for New Toys 

€} > ONSALE - Auctions of Cornputers and Electronics http dwaw 

8 Kai's Power Tips and Tricks for Photoshop http wthe-tech rut: 

8 Ib Adobe Systems - Frarne products hito fwww frame com! 

& > Sun Microsysterns http Hwww sun corn 

(a F Tips fer the Job 

's) » Technical Writing Page http user itl neti qazzalte 

€B  InfoSeek Guide Search for technical writing hth Wguicte pint 

€} 'P Tom's Tips for Web Designers hip ithe-tech rrit edits PT 
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The Contents is ar 

The Contents displays an ou 

just click its icon in the Con 

WebArranger ships with thr 

Each Folder has several Top 

WebArranger window, 

Its easy to customize your C 

in the outline. Move them ir 

drag Notes from the Shelf o1 

For more customizing infor: 
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The Contents is an outline of Folders and Topics. 

The Contents displays an outlined list of the Folders and Topics, To navigate to any Topic or Folder, 

just click its icon in the Contents area of the screen. 

WebArranger ships with three Folders: Jump Start, My Data, and Internet. 

  

Each Folder has several Topics in it, When you click a Topic, its Page displays on the right side of the 

WebArranger window,       
  

  

    

  

It’s easy to customize your Contents — just use drag-n-drop. Move Topics and Folders up and down ID) Revelations a 
. . . oe J Start 
in the outline, Move them into, and out of, other WebArranger Documents. In addition, you can cq ume 

336 READ NOW!!! ensepeee ee URLS and: ea drag Notes from the Shelf or from the Page to other Topics. LA Top Ten FAQs List 
‘you more contol over your Netscape bookmarks, wo . : ; : . ' ‘ 

, P For more customizing information, see the Cool Tricks section at the back of this guide. Ga Cool Picks 

Day hitowww.dsu.edulproject... . Ci] My Data 
an Stock Exchange - The Smarter P.... htiptiwww a Clippings 
ds Online httpdiwww.mimag.com - People Fl 
2ython page hitpalired.u.washington.... 

EEE Web Schedule [Fy 

hannel Online hito:wwwdiscovery. com! 2 UserDefined# 
UserDefined #2 laces On The Net hitp:www.euronet.nituser... 

eum http iwww.ncb.goy.sginhbi... 

2b Worid hitp:icyclone.weather.nett.,, 

it httodiwwey.aze,comiclient!, 

Toys 

\uctlons of Computers and Electronics hitodiwww 

‘Tips and Tricks for Photoshop hitp:the-tech.mit. 

ems - Frame products hitovwww frame.corn 

sstems hthodhwww.sun.com! 

. y Internet    

   

  

my WA Foot Steps 

)} Invalid URLs 
GQ) FTP Download Agent 

Successful FTP Do... 

     

  

   

friting Page http:tuser.itl net~gazzaite... 

Jide Search: for technical vrting hito:iguide-p.int 

‘or Web Designers htip.ithe-tech.miteduiKPTH... fi Trash ras         

WebArranger 2.0 WebArranger 2,0 ©   ee ee 
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The Note types you use most often are kept on the Shelf. 

The Shelf is in the lower left corner of your screen. Click a Note type’s rectangular button on the Shelf 

to insert a new Note on the Page. It will automatically appear where your cursor was last positioned. 

You can also click the Note type’s icon and drag it to the Page or to a different Topic in the Contents. 

  

  

    

  

  

  

  

  

  

  

  

  

  

  

    

+ 

- J fe 
(“Heading 

‘th [To Do | 
(? [Memo | 

fi) | Peo ple | 

| 
| 

  

  

  

(S| Bookmark Heading| 
          

© WebArranger 2.0 
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The Document is 1 

The Document contaimys all: 

have three different people \ 

want to share information b 

two Documents that are ope 

In the File menu, under Pre 

vou launch the application. 

adjust a variety of other sett 
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COOL TRICKS 

The Document is the “master” file type of WebArranger. 

oe 
ae 

a 

  

ow 

C    
helf The Document contains all of your Topics, your settings, your customized Note types, and everything else. If, for instance, you 

d, have three different people who use WebArranger at your household, each person can create his or her own Document. If you 

ts want to share information between two different Documents, it’s easy to copy-and-paste, or you can even drag-n-drop between 

  

two Documents that are open simultaneously. 

In the File menu, under Preferences, you can select a Home Document, which WebArranger will automatically open whenever 

you launch the application. In the Preferences dialog, you can also password-protect your Document, automate backups, and 

adjust a variety of other settings. J 
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ee 
ip 
  

[Picture 
    
  

  
  

‘Bookmark Heading|   
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COOL TRICKS COOL TRICKS 

  

Navigation in WebArranger is smart, but a bit different. Launch You 

  

Select a Note — Click any Note’s icon to select that Note. A box displays around a Note when it’s selected. Once selected, you can 

copy, cut, drag, gather, or launch URLs. ; 

  

Open Note — Click once in the Summary Line (or title) ofa Note to open or close it. 

Launch vour favorite brow 

Select a URL Note, press - 

Show Sub-note — The small arrow to the right of a Note’s icon indicates two things: 

m If itis a double arrow, there are clones of this Note in the Document. A clone is a replica of a Note. 

w When the arrow is solid, there are sub-notes to the Note. To show and hide the sub-notes, click the arrow. See the Cool This is very handy for erui 

Tricks section of this guide for more information about Clones and Sub-notes. For example: 

Drag-n-Drop — When you select a Note, you can drag-n-drop it. You can drag-n-drop a Note from the Page to a different Topic. If vourve scheduled yourse 
You can also use drag-n-drop to quickly and easily rearrange Notes and sub-notes on a Page. Gray bars display to help you drop a . from your To De list. This 
Note where you want it. ; re 

No mater which Topic vo: 

Cet started by surfing to s 

predefined sites in the Cox 

Topic. We've provided sets 

to get you started, includir 

Politics, News Sources and 

the Family. If you've install 
| 

configured WebArranger ¢ 

youl be able to browse an 

icluded sites with a simpl 

keystroke, 

© WebArranger 2.0 WebArranger 2.9
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f Launch Your Favorite Web Pages Directly From 
& e WebArranger With One Keystroke! 

  

; selected. Once selected, you can 

  

CPC et ee ae ee en De 
Launch your favorite browser and go to places on the Internet, automatically. 

of a Note. Select a URL Note, press 9¢-R, and you're there! 

click the arrow. See the Cool This is very handy for cruising directly to a Web page from WebArranger! 

For example: | 

im the Page to a different Topic. If you've scheduled yourself a To Do Note to check a certain Web site, you can check your calendar and launch that URL directly 

y bars display to help you drop a from your To Do list. This is because To Do Notes are linked to URL Notes. 

No matter which Topic you create a To Do in, the Web Schedule Topic auto-collects To Do Notes! 

  Get started by surfing to some of the GD Visit the internet 
  

  

  

predefined sites in the Cool Picks Summary: Visitthe Internet 

Topic, We ve provided sets of URIs URL Link: (4) GB !b Ask Dr. Science hfte:#agora.rdrop.com/~jim... 
to get you started, including Sci Fi, URL: http:iagora.rdrop.chmi“inkaltextidr_sclence tint 
Politics, News Sources and Keep It in . Comment: Ask Dr. Science 

Last Yisited: 9 EQ Sun, Feb 11, 1996 @ 4:01 PM the Family. If you’ve installed and 
Next Time to Yisit: @ OQ 

configured WebArranger correctly, 
  

you'll be able to browse any of these Priority: 

included sites with a simple 3¢-R Begin: BOO 
keystroke. Completed: [_] 

Date created: Mion, Feb 12,1996 @ 8:20 PM       

WebArrangar 2.0 ‘ WebArranger 2.90 © 
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COOL TRICKS 

Install Internet Plug-in 

    

  

  .¢ Internet Power Tools ae 
Launch URE aE 

Clean Up “Changed Web Pages” Topic 
WebArranger ships with an impressive set of Internet power tools. See the Help Agents » 

Document for more information about the Tools menu. Start WWW Foot Steps 
Import/Export » 

Launch URL Internet Apps >     
  

Here’s Cool Trick #1! But we already showed you how to do this with a s-R 

keystroke — much easier than selecting it here. 

Housekeeping 

Every now and then, you should select the Clean Up Changed Web Pages Topic tool. This Topic is the repository for URL Agent 

missions. You won't even get dirty. 

Agents 

Select this tool to display the list of WebArranger Agents that can do so much for you — Start URL Agent, Start URL Validator 

Agent, and Start FTP Download Agent, 

Start WWW Foot Steps 

This command begins the capture of your cyberspace vapor trail, recording your complete browsing history. 

Import/Export 

This displays a menu of options to import and export Netscape history, and bookmark import/export for Netscape Navigator'™ 

and Anarchie™ bookmark management. 

Internet Apps 

The list of Internet Applications rounds out your set of power tools. The list includes Internet Config, Forefront Group’s 

WebWhacker”, your browser, FTP client, E-mail client, news reader, Telnet, Gopher, etc. 

© WebtbArranger 2.0 
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» Customize Y 

Make some Topics of your ov 

1. Click the User Defined 

To change the new Topi 

m@ Select Topic Setting: 

@ Click the icon butte 

m Select one and click 

You can also paste an ic 

2. Go to the Cool Picks Top 

m For example: You ha 

HB You name the User | 

@ Click the Cool Picks 

m Drag the icon of the 

m All the sub-notes to 

m It’s that simple. 

= If you want to add s 

You can put additio 

3. You're already building y 

WetArranger 2.0
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ternet Plug-in . 

Customize Your Stuff 
iL 3eR 
“Changed Web Pages” Topic 

> Make some Topics of your own! 
W Foot Steps . vo. . . ae . 
Hport » | 1. Click the User Defined Topic in the My Data Folder. Then click again to highlight the name, and change it. 

Apps > To change the new Topic’s icon: 
  

M Select Topic Settings in the Topics menu. 

™ Click the icon button and look through the icon library. 

m Select one and click OK. 
is the repository for URL Agent 

° You can also paste an icon into the Topic Settings. Select the icon box beside the icon button, and paste. 

2. Go to the Cool Picks ‘Topics, and choose a group of URL Notes for your new Topic. 

RL Agent, Start URL Validator | m For example: You have an interest in politics, 

| m You name the User Defined Topic Politics, 

m Click the Cool Picks Topic. 

_ sing history. Drag the icon of the Heading Note called Politics to your new Politics Topic. 

m All the sub-notes to the Heading come with it! 
; TM xport for Netscape Navigator m It’s that simple. 

m Ifyou want to add some news sources to your Politics Topic, drag-n-drop URL Notes from News Sources to the Politics icon. 

You can put additional People in Politics with their E-mail addresses too. 
onfig, Forefront Group’s ye . . Lo . 

& FOF P 3. You're already building your own Web information set, and it’s the way you want it. 
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6 Grah Stuff Anywhere, Any Time! 

COOL TRICKS 

WebArranger’s Universal Grabber” lets you grab any kind of information and place it in your Document. Most grabbed material is 

placed as a Memo Note for later filing. But the Grabber is smart enough to recognize a URL, and place it asa URL Note. 

The best part — the Grabber works whether or not WebArranger is running! 

1, Select what you want to grab, like a URL, text on a Web site, a piece of a Microsoft” Word 

document, an image in Adobe Photoshop”, or an E-mail message. 

2. Press your Grabber hot key and voila! The Grabber puts a Memo Note or a URL Note in the 

Clipping Topic in the My Data Folder. 

You can drag your new Note and drop it where you want. 

Or, convert it to another type of Note. See Convert Note in the Notes menu. 

  

Cut, Copy and Paste work too! You can cut or copy any information from anywhere | uA 

and paste it into a new Note. This can be especially handy for organizing new Web | 

sites as you find them. Highlight the URL, copy it, go to WebArranger, select a new 

URL Note, and paste the URL. You can then title the Web site (using real English 

| 

| 

| 
rather than the cryptic URL) and drop in a graphic directly from the Web page | 

| 

Comment: 

Last Yisited: 

Next Tine lo Visit: 

Error Desaription: 

Outdated URLS: 

Last Download Attempted: 

using the same copy and paste technique. Hold your mouse button down while 

pointing to a graphic, and you'll be able to copy it. 

QuicKeys® 

If you use QuicKeys, or if you want even more automation, check the CE Software | 

  

    

      
    

  

4 Grabber Preferences 
YY ence 

a 
Grapper; fe] 

WebArranger: st 

Bj iol Keys enabled 

@ Moke sound uthen grabbed 

     
San Francisce 49ers blip Avww nilhome coneamsd gersdaers hav 

hitty Avavw nfihome comiteamsid Gersiddars hin! 
San Francisco 49ery 

Poo 
Pao 

aoo 

  

  

Web site for FREE QuicKeys keysets. With the keyset, you can select the Note type 

and the location on the fly, and bypass the Clippings Topic. 

The free keysets require QuicKeys, the leading Macintosh” automation and scripting product, 

QuicKeys is available from CE Software at a special low price for WebArranger owners. 

© WebArranger 2.0 

Concei | ; 

  

O
T
T
 

* 

  

ot 5 Try 
= yh 
~ C&) ~ 
OL TRICKS 

Do it Fasi 

  ag - F 

Note throughout a De 

WebArrange: 

ag - J — Navigate fror 

View FAST with the G 

Go To’s incredi 

lists of Topics a 

and as soon as 

do it! 

ag - N — Create a new 
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There are a number of 

navigation. For a come 

Jump Start guide. 
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   e Do it Fast ... With Hot Keys! 

  mt. Most grabbed material is 9g - F —- WebArranger’s quick Find feature locates any text string in any 

it as a URL Note. Note throughout a Document.   

  

  

Go to Folder/Topic/View:|Peopte 

Matching: People 
  38 - J — Navigate from Topic to Topic, Folder to Folder, or to another   

      
yrOOeerrJev - View FAST with the Go To hot key. . : | 

a = . . . tae Cancel | 
Sranber: | Go To’s incredible type ahead feature recognizes your existing a 

Wentrrenger: [_—___ lists of Topics and Views in your Document. Just begin to type, 

and as soon as the characters match something in your Document, the whole name displays. Usually, one or two letters will 

do it! 

vot keys enabled — 

Bi Moke sound when grabbed 

  

  
  9g - N — Create a new Note, anywhere, any time in WebArranger. The new Note dialog also features the same type ahead feature. 

The dialog also offers a pull-down menu of your Note types. 
  

Atte Anwew. nfihome.conmearns/49ers/49ers. hime 
  

  
  

  

  

    

Ls htoUAww.nfihome.comteams/4 9ersi4 Sers.himi 
« ae 

Memo 

«900 There are a number of other hot keys for even faster New Ng nie ding 
® ano navigation. For a complete listing, check the WebArranger Make note of type: [1 [qian WE) kite 

Jump Start guide. ea tment 

— Define Note... ( _0K | Reminder 
sail eee IIMPI Preferences 

3 People 
av Picture 

| Bookmark Heading     
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COOL TRICKS 

Outlining Made Easy! 
Use Clones and Sub-Notes to Organize Your Stuff Your Way! 

We hated outlining in 6th grade, but it's one of our Top Tricks now! 

Notes 

organ 

CLON 

Notes 

are free spirits. You can relate Notes to other Notes or Topics in your own way. By creating Clones and Sub-Notes, you can 

ize your Notes in the outline format, and make some kind of sense to it all. 

in one Topic can be “cloned” into other Topics. Since there is only one actual, physical Note in existence, changes to a 

  

cloned Note appear in all other clone copies. 

For example: You have a URL Note to the Apple Computer Developer Page. You have a Software Heading Note in your Cool Sites 

Topic, You have a WebArranger Plug-in Development Topic, and a Software News Topic. It makes sense to you to have that Apple 

URL Note in all three places. No sweat. 

Hold the Option key down while you drag the Note from the Page over to one of the Topics. 

Do the same for the other Topic. 

You've just made clones! 

If you make a change to the cloned Note in the Software News Topic, the change is reflected in the Cool Sites Topic and in 

the Plug-in Development Topic. 

This is a very good use of your time. 

WebArranger 2.90 

  

When vou drag a Ne 

above or below anot 

Outlining 

‘Try this vourself, and 

Notes you want in se 

your stuff the way vo 

IMPORTANT: Whe 

one version of the N 

Destroy Note in the 

the Note, including i 

attached to that Not 
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SUB-NOTES 

When you drag a Note’s icon, gray horizontal bars display to help you drop it where you want it. You can drag-n-drop a Note 

above or below another Note, and move a Note to indent it. An indented Note below another one is called.a Sub-Note. 

Outlining 

Try this yourself, and see how flexible and powerful WebArranger is! Make some clones of 

Notes you want in several Topics. Drag Notes around to create an outline ... just rearrange - 

your stuff the way you want it to be, 

IMPORTANT: When you select a Note and press the Delete key, you are only deleting that 

one version of the Note. Its clones are still around. If you want to delete all clones, select 

Destroy Note in the Edit menu. Be very careful! Destroy Note eliminates all versions of 

the Note, including any places where it is a Sub-Note. It will also delete all Sub-Notes 

attached to that Note. 

WebArranger 2.0 

  
  

  

¥ Fun 
@ | hipziwww.usc.eduldeptigardent Th 

> hip.iwww.expanse.com:8Glep/infory 

€ > http:siwewama caltech.edulusersim 

& )> hitp:tialfred.u.washington.edu:8080! 

& | hitp:tiegowww.homepages.com/ LE 

&} > hup:icyclone. weather netitoland? Za 

¥ Cartoons 

& | hitpvwww.ausweb.com.aulFa 

& > hitoviwww.unitedmedia.comic 

&  hitevagora rcrop.comi~jimkal 

& > hito:iwww.grimmy.com! Moths   
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Merge Personal Information 
With Your Internet Information! 

L. Select New in the File menu. 

2. Select the Organizer Template and click Open. 

J. Copy the Organizer Folder from the Organizer Template 

onto your Contents. To copy it, hold the Option key while 

you drag the Folder. (It's possible to drag-n-drop items 

between two open Documents in WebArranger.) 

4. Close the Organizer Template. 

a
 

kind of information from anywhere, and use WebArranger to handle it, 

WebArranger ships with an Organizer Folder already set up to manage the rest of your life. 

C&) 
COOL TRICKS 

You have the idea by now that WebArranger does a lot more than just manage vour interaction with the laternet. You can eet any 
he aw 1 4 

  

  

  

  

v3 WebArranger ¥ 

Please choose @ Custom Template or click New: 

  

{J internetConfig!.2 

(7) Plug-ins 

WA 2.0 Template 
(7 WebWhacker 

(J Organizer 

  

<= Dale 

Eject 

Desktop 

Open 

New     Cancel 
    ie
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The Organizer Fold 

personal calendar as 

To combine the two 

1. Make a back 

2. Open the W 

3. Click the tin 

ofa calenda 

4. Press © = At 

a. Drag the No 

CTE 

  

You can put addition 

Appointment and R 

organizer. This exan 

schedule Topic. 

Plus, vou can add, st 

Cool Trick. 
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        THE SCHEBULE TOPIC ae 

The Organizer Folder has a Topic called Schedule. It behaves similarly to the Web Schedule Topic. You can keep both, and have a 

personal calendar as well as an Internet calendar, Or, you can combine them so you have just one calendar Topic. 

th the Internet. You can get any 

To combine the two: 

1. Make a backup copy of your Web Schedule Topic. Save your Document in TAIL format, then make a copy of the TAIL file. 

  

  
  

1 Template or click New: | 2. Open the Web Schedule Topic. 

3. Click the tiny white box in the upper left corner of the Page. This displays the Notes in a View that is a simple list, instead 

ad : of a calendar. 
cH <> Dale : 

4. Press 9¢ - A to select all the Web Schedule Notes at once. 

Jeet | 5. Drag the Notes to. the Schedule Topic in the Organizer Folder. 

  

  

| NEW NOTE TYPES (0 

[open _} : You can put additional Note types on the Shelf, You may find the 

| 
Pick up phote Sun, Feb 11, 199.. 

Appointment and Reminder Notes useful in creating a personal 

organizer. This example is an opened Appointment Note in the Web     
    
  
  

a Cancel 
Schedule Topic. Web Schedule:Toda 

, . BOP Dinner with Jill 
Plus, you can add, subtract, and rearrange fields in a Note, See the next Summary: 

Cool Trick. Who: [) 
Category: &) 

Where: —] Bob & Iris’s Drop Dead Cafe 
Comments: take photos 

Begin: 9D (QQ Sun, Feb 11, 1996 @ 7:00 
End: 9 

WebArranger 2,0 WebArranger 2.0 

— —a 7 sparen r pmn 
ea AE al oe A EE aa UE Ee RAS PEL BAERS oP Pet TOA AE OH SS fee a ek we ke Ne id ee i ek 

  



tie eR eT cE 

   = @®* 
COOL TRICKS    

    

« Customize Your Notes — Browse the Note Catalog 

Want to track your appointments? Want to remember someone's birthday or anniversary? Need to add descriptions to Web 3. Select the fic 
2 i addresses so you can easily categorize them? Customize your Notes in the Note Catalog! The other bt 

In addition to other Note types, the Note Catalog offers additional fields to put in your existing library of Note types. For more 

information, see the Help Document (select Help in your Apple menu.) 
IMPORTANT: Wher 

Birthday field to the | 
  The Note types you use most frequently are stored on the Shelf. To add a Note type to the Shelf: ERE WA 2.0 US Template:Note Cotolog Set 
  

  

    

  

  

  

  

  

  

     

   

  

1. Select Note Catalog in the Notes menu. mote cole type, that field is rem 

2. Drag the Note type you want to the Shelf, To edit just one speci 

To remove a Note type from the Shelf: ("delete } 1. Open the Nc 

1, Select the Note icon and drag it to the Trash in Contents. 2. Select Add Fi 

2. This does not remove the Note type from the Note Catalog, Click the Delete button in J. Type the fiek 

the Note Catalog dialog to remove a Note type. Be careful! When you Delete a Note type Add Field diz 
from the Note Catalog, you remove that Note type from your Document — all Notes of 4. Click OK 

‘ s . 

that type from the Topics, and all the information stored in those Notes! 
Pa re eet Catine Note TRALEE rT 

To change the fields in a Note type: Qetine Nute 
; ; | Fates Nale Name: Nale [can WARNING: CE Softy 

1, Select the Note type and click the Edit button. | sort ny (ization ¥] (a) Crean) 
| (winie tos gP ranger. Some Note ty 

2. Select the field you want to add from the field list on the left side of the Define — | ean ; transparent to you. 

Note dialog. Click the >> button.     
To rearrange the field’s position, drag it up or down in the Note type display on 

the right side of the dialog. a mes 
New... a ummaory... ence . ook 

1 te   
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ALriaseoedd Define Note FRE IREFRPEET CIDE 

_orine ote 
Note Ramet Note Icon: 

fon +} [Rppolniment 1 faa) leone. } 

ae - 

     4 

Form:(WaFora >} 
{ Edit... } (Summory.. } { Cancel t OK J 
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3. Select the field you want to remove and click the << button. 

The other buttons in the Define Note dialog let you further customize a Note type. See the Help Document. 

IMPORTANT: When you add, remove, or edit a field in a Note type, that change is made to all Notes of that type. If you adda 

Birthday field to the People Note, all the People Notes in your Document will display that field. If you remove a field from a Note 

type, that field is removed from all Notes of that type. 
  
  

To edit just one specific Note: Add Field 

1. Open the Note.    
  

        
  

* Select Add Field or Remove Field in the Notes menu. To: @ selected note O all notes of this type rE 

. Type the field or select it from the drop-down list in the - 
Add Field dialog. (Define Field...)  [ Cancel | Cx") 

4. Click OK. 

WARNING: CE Software recommends that you not remove the Note types and associated Note fields that are shipped with WebAr- 

ranger. Some Note types and fields are required by the WebArranger program, although their activity or importance may be 

transparent to you. 

WebArranger 2,0 © ® 
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The Gather Command — 
WebArranger's Query-by-Example 

  

  STETETT 
4. Press “Mle 

      = Matched Notes 
  Want to quickly locate all of your contacts who have an AOL E-mail address? Need 
  

: Vogt . & Matched Notes : » die to find your URL Notes regarding Astronomy? WebArranger’s Gather command Is 2 “= promptly dis 
. Ihe following angles match. Chek on a nete ta select it, oF . . 

the tool for you! bald dou the shift key and chek to select mare than ape ( nme tt fhe 

, note, To insert all inatching notes, click the tnasert alt 
bullon. - ~ utlon . a J. Select the UF   

To use Gather: . 3 iP Gentral Source Tel Page, nip were fAlephenebe nd cory 

&  Centralinelligence Agency Home Page bitp dveenk Ook igre! 

1, Open the Topic into which you want to put the gathered notes, B. rhe URL is Ii 

2. Create a Note type like the one you want to find. 

  

  
  3. Fill in the appropriate fields with text strings to match what you're seeking.     {_Insertan — } {_tancei ) (x) 

4. Press ae - M to activate Gather. = ee 
  

5. WebArranger finds the Note and places a clone of it in the Topic. 

  

6. The Matched Notes dialog displays when more than one Note is Jocated. Select one or more Notes lo insert. 

  

  

  

| Gather works with To Do Notes too! For example: 

You want to schedule a visit to a certain URL, but all you Er 

remember is the Comment field begins with “Welcome.” Summary: Visitthe internet 
| URL Link: aa[we) 
: 1. Create a To Do Note. Priority: a sana 

. Begin: DOO 

2. Click the field URL Link. Completed: [J 

: Date created: Tue, Feb 13,1995 @ 1058 AM   
  3. Type Welcome and press Return, 

€ WebArranger 2.0 WebArranger 2.
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| . 

Fc 
Matched Notes Ee===s=ee sees] 4. Press 38-M to activate the Gather command. WebArranger a Matched Notes = 

Matched Notas promptly displays a list of URLs that have Welcome in the Matched Notes 
The following notes match, Click on @ note to select it, or a wy and ellck to select more then one Comment field. owing notes match, Click to select it 

tching notes, click the insert fll hold down the shift key and click to select more than one e 
: . : note. To insert all matching notes, click the insert All = ow Pages Hipinanvlalophonebookooul 3B. Select the URL you want. A box displays around it. Click OK, button, 

Agency Home Page hip dawway.odel. gov! 5 sys @ Welcome to Britannica Online nttpdnwyw.eb.conv 
; . 1 . . 

The URL is linked to the To Do Note. Cool @& > Welcome to MacUserWeb hipyizclas3.zi.comi% 7E... 

@ » Weicome to UCMP! hitpziucmp1 berkeley.edur... 
@ > Welcome to the White House hitpuiwwwt whitehouse.g... 

| @ > Welcome to the Whke House httpdivwvrl whitehouse... 

tance) — @ > Welcome to UCMP! hitptucmp1 berkeley.edu:... 
J (Concet } LK Pa Welcome to Maclkerwah hin deca coms 

Totes to insert. 

t 

| 

8AM = 

7 
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    © A Room With a View 

  

Collect the sites you 

TAIL file (read more 

Document as a new 

access to al] the sites 

entering URLs or co 

Views give you lots of ways to look at your Notes on the Page, including sorting on the fy. 

WebArranger ships with three Views: Basic, Table and Calendar. Some Topics are shipped with Views created for you —~ People, 

Web Schedule, Bookmarks, and History, A Topic has more than one View if there is an arrow on the right, beside the Topic's 

name in Contents. Click the arrow for a drop-down list of the Views. 

Basic View — This is the generic View of your Notes. The Notes are displayed ina list format. The Filter and Sort commands in 

the Views menu let you rearrange the list according to Note types and field contents. See the Help Document, 

. ; , ; . 7 You can also use this 
Table View — Your Notes display in a table format, with the fields as columns. Move the columns around to rearrange a Table ‘ 

View any way you like. 

f
n
 

Ul
a 
e
l
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e
 

e
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Each column has a drop-down list so you can change the information displayed. WebArranger ships with Table Views for the 

People and Bookmarks Topics. 

  

Calendar View — WebArranger offers a variety of 
    

  

  

    

   

  

    

  

      
  

‘ m3 SS momaneriinte — . er CPE STC 

calendar formats to display your Notes. You can Contents LES LF | ited Geb 1s S960 SSIS BM ee Peopl 
! “yo . . . Pp " 
‘ select the details in Calendar Settings in the Views I ¥A 2.0 Template ow Sorted by 
: . aoe _ A : 

menu, Calendar Views are built into the Web 4 Jump-Start Last Name [First Name email 
: . : 4, READ NOW! Alexander Lamar ailto :Brad_Kiew 

Schedule and History Topics. Note that the calendar cA > ° eee” 
. . . . / Top Ten Fans List & pb Buchanan Pat 

View scales with the size of your WebArrange! Cool Picks 
ind “ Clinton Bin mailto :olinton@w 

Window. My Data 
> . . K mts: Dole Bob 

When you've enjoyed WebArranger for awhile, you ps Clippings . se 
! ; oe fA > Forbes Steve mailto ferbes@ra 

may want other types of Views to suit your needs, = . 
. . : . . HH Web Schedule p> Geodman Ford mailto :Ford_Geedi 

More information regarding the Views menu is in Ey og . 
; the WebA Help D ‘ User Defined FI pb Kiewel Brad mailto :BradKiew 

e WebArranger Help Document. Fined # 
6 P fi) User Derined #2 GP Rinehart Mick mailta Mick Rine 

1 Internet 
I & > Yarnum Duane rmaitlte -Duane_¥ ar 
I Bookmarks fet 

| 
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Share Ready-To-Launch URL Collections 
With Other WebArranger Users! 

ra
re

 
a
e
 

  

ee
s 

a 

Collect the sites you want to share into a Topic, then select Export Topic in the File menu. Export the Topic as a 1 
TAIL file (read more about that in the Jump Start guide). Your friends can then import the TAIL file into their 
Document as a new Topic, then reorganize the information as they wish. They'll have instant one-keystroke 
access to all the sites you passed along, including all-of your annotations and Notes. Sure beats manually 
entering URLs or copying-and-pasting them one at a time from E-mail messages! 

ar
en
 

reated for you — People, 

tht, beside the Topic’s 

  

er and Sort commands in 

ument. 

ind to rearrange a Table You can also use this trick to share contact information and just about anything else you have stored in WebArranger! 

ith Table Views for the 

      

  

Lamar mailto :Brad_Kiew 

  

Pat 

Bill mailto :olinton@w | 

Bob 

Steve mailto: forbes@fa 
~ 

Ford mailto :Ford—Good 
' 

Brad mailto :Brad_Kiew 

Mick mailto :MickRine 

Duane mailto :Duane—Var 
* 
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» » » ‘There Are More Tricks Ahead! 

WebArranger offers opportunities for third parties to develop vertical applications! 

CE Software has initiated a developer program which will introduce more add-on products and functionality 

to make WebArranger even more powerful! 

  

WebArranger has a very well-defined plug-in Application Programming Interface (API). New features and 

functions can be added by CE Software or by other developers who use WebArranger’s Software Development Kit (SDK). 

Stay tuned to CE Software World Wide Web site for details on forthcoming WebArranger Plug-ins and third-party development 

opportunities. 
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